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ABSTRACT

Firewall Manager is a desktop application that allows a user to create
and manage linux- based firewalls. Firewall Manager is designed to handle
environments with a single firewall and few rules, all the way to a large
environment with many firewalls and complex rulebases. Either one should
be able to be deployed and managed easily and securely, with a minimum of
effort. Firewall Manager represents all rulebases (or policies as we'll call
them) as one or more simple tables, populated with graphical objects
representing various objects on your network. For example a web server
would be defined as a Host, and there are also Firewall, Network, and Group
objects available. Firewall Manager can then generate the scripts necessary
to configure iptables on your remote firewalls, and securely transfer those
scripts and execute them on the firewall. This application allows a user to

monitor multiple firewalls easily from one client console
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1. INTRODUCTION
1.1. Existing system and its Limitations
Network security is a primary consideration in any decision to host a
website as the threats are becoming more widespread and persistent every
day. One means of providing additional protection is to invest in a firewall.
The default firewall in Linux is iptables. iptables is a generic table
structure for the definition of rulesets. Each rule within an IP table consists
of a number of classifiers (iptables matches) and one connected action

(iptables target).
Tables available in iptables:

All packets inspected by iptables pass through a sequence of built-in
tables (queues) for processing. Each of these queues is dedicated to a
particular type of packet activity and is controlled by an associated packet

transformation/filtering chain.

There are three tables in total. The first is the mangle table which 1s
responsible for the alteration of quality of service bits in the TCP header.

This is hardly used in 2 home or SOHO environment.

The second table is the filter queue which is responsible for packet
filtering. It has three built-in chains in which you can place your firewall

policy rules. These are :
e Forward chain
o Input chain

e Output chain



The third table is the nat queve which is responsibl

address translation. It has two built-in chains, these are:

e Pre-routing chain

e Post-routing chain

Limitations

1) iptables is command driven.

2) Difficult to configure.

3) More overhead for Administrators.
4) Less flexible and scalable.

5) Difficult to manage.

6) Time consuming process.

7) Module dependency.

e for network



1.2. Proposed system and its advantages

The proposed system represents all rulebases as one or more simple
tables, populated with graphical objects representing various objects on your

network..

Features
e Create objects in object tree
o Create a Managed Firewall object
e Add and/or edit firewall rules
e Add and/or edit NAT rules
¢ Generate Scripts

e Install and Uninstall Policy

Advantages
e Itis easy to maintain and configure
e Easy to install and uninstzall the scripts
¢ It provides less overhead for administrators
« More user friendliness and less time consuming

e Easily understandable by all novice users

('S



2. SOFTWARE REQUIREMENTS SPECIFICATION

21 Introduction

2.1.1 Purpose

The purpose of this requirements of

document 1s 10 specify the

1t describes the interface
ween the customer

s for the system.

project «Firewall Managet”

The document also bridges the communication gap bet

and the analyst.

2.1.2 Scope
the client and the

SRS forms the basis for agreement between
the software product will do. It also provides a

dation of the final project.
ade to the SRS in the future will

supplier and what
reference for the vali
Any changes m have to g0 through
formal change approval process.
2.1.3 Definitien
Customer:

A per

son oOr organization, internal or external to the

ion, who takes financial responsib

is may not be the end user. The
d its artifacts.

roducing organizat ity for the system.
p Y

In a large system th
the developed product an

customer is the

ultimate recipient of

User :
A person who will use the system that is developed.

Analyst
The Analyst details the specification of the system's

functionality by describing the requirements aspect and other supporting

software requirements.



1.1.4 Abbreviation

SRS . Software Requirement Specification
JDK . Java Development Kit

SSHD . Secure Shell Daemon

LAN . Local Area Network

GUI . Graphical User Interface

2.1.5 References
“An integrated approach to software engineering” by Pankaj Jalote.

«Qoftware Engineering” by Roger S. Pressman.

2.2 General Description
2.2.1 Product Overview
This system aims {0 provide the administrator complete
control of his LAN through the server. It is a GUI based client firewall
particularly in large, complex environment. Security policies are easy to
build, view and audit, as well as common tasks normally done on the
remote firewall.
2.2.2 User Characteristics
The main user of this system is the administrator who is
in charge of the network. He is expected to have a basic knowledge of
firewall and its operations.
2 2.3 General Constraints
Initially this is designed and tested on *nix-based clients.
Windows support for remote firewall management is not on the short list

of objectives.



2.3 Specific Requirements

2.3.1 Inputs and Outputs

The input to th
strator privilege is used for installin

e system are the host objects, Services,

network and firewall. Admini g and

running the scripts successfully at all run levels.

The output from the system are the iptables compatible

scripts to be executed at the run level.

2.3.2 Functional requirements:
i.  The system should be able to authenticat

trator and control the network.

e the network

adminis

stem should allow the network administrator to perform

ii. Thesy
the desired functions with ease.

2.3.3 Performance constraints: .
The modules such as CONFIG_IP_NF_CONNTRACK,

CONFIG_IP_NF_FTP, CONFIG__IP__NF_IPTABLES,
system to work

CONFIG_IPF_NF_FILTER are required for the

efficiently.
2.3.4 Software Constraints:

The system runs on Unix based platforms and requires iptables and

sshd running.



3 LITERATURE REVIEW
3.1 Firewall
A firewall is simply a host whose main purpose is to protect your
network. A firewall restricts certain types of network traffic from the
Internet to your protected network(s) - the reverse is also often true.

3.1.1 Types Of Exploits

e Local - There is no security without physical security. If someone
has physical access to your box, you've lost. Obviously, a firewall
won't help you here.

e Local privilege escalation - The trojan horse attack. The attacker
already has a local account on your box (inside the gates) and
obtains root by some means (vulnerability or misconfiguration). A
firewall cannot protect again this type of attacks.

o Remote - Your host is listening on a port that the attacker is able to
connect to remotely over a network and exploit a vulnerability
somehow. This is the only type of attack a firewall can (hopefully)
protect you against. There is another important point here that most
firewall often neglect. In order for someone to exploit your box
remotely, it has to be listening on some ports (1.e. providing a way
for an attacker to connect). Therefore, if your host isn't listening on
any ports, you are safe from remote exploits (unless the attacker
manages to attack the network stack itself).

3.1.2 Need For A Firewall

» Increase your network security - Some services are inherently
insecure and impossible to secure o1 individual hosts. A. firewall
can help you segment and contain parts of your network to increase

security.



o Network access control - A firewall can help you enforce your
network security policies by selectively allowing network services
(to all or selected hosts).

o Logging - Because 2 firewall must examine 21l inbound/outbound
network traffic, it can help you log network activity (that passes
through the firewall).

3.1.3 Types Of Firewalls

e Proxying firewall - Proxy servers work by making requests on
behalf of your clients.

o Packet filtering firewall - Packet filters work by examining the 1P

packets .

3.2 Packet Filtering

A packet filteris a piece of software which looks at the packets as
they pass through, and decides the fate of the entire packet. It might
decide to DROP the packet (i.e., discard the packet as if it had never
received it), ACCEPT the packet (i.e., let the packet go through), or
something more complicated.

3.2.1 Advantages Of Packet Filtering
CONTROL:

When you are using a Linux box to connect your internal network
to another network (say, the Internet) you have an opportunity to allow
certain types of traffic, and disallow others. For example, the header of
a packet contains the destination Address of the packet, so you can

prevent packets going to a certain part of the outside network.



SECURITY:

When your Linux box is the only thing between the chaos of the
Internet and your nice, orderly network, it's Lice to know you can restrict
what comes tromping in your door. For example, you might allow
anything to go out from your network, but you might be worried about
the well-known "Ping of Death' coming in from malicious outsiders.

As another example, you might not want outsiders telnetting to
your Linux box, even though all your accounts have passwords. Maybe
you want (like most people) to be an observer on the Internet, and not a
server (willing or otherwise). Simply don't let anyone connect in, by
having the packet filter reject incoming packets used to set up

connections.

WATCHFULNESS:

Sometimes a badly configured machine on the local network will
decide to spew packets 10 the outside world. It's nice t0 tell the packet
filter to let you know if anything abnormal occurs; maybe you can do

something about it, or maybe you're just curious by nature.



4. FIREWALL MANAGER
4.1 Architecture

packets kiled
DROPped /
REJECTed Systern with netilterfiptables
Firewall
_ ntema
AcCEPTed _
- -~ FORWARD %,mm'
packets to forwa > chain
OUTPUT
e chain sl -
ACCEPTed Qutgaing packets

Fig No.4.1 Architecture of Firewall Manager

10




4.2 Packet Processing

Pk Cut

NetworkB

Fig No.4.2 Flowchart for Packet processing

ined by your rules in the mangle table's

The packet is first exami
PREROUTING chain, if any. | the rules in the nat
table's PREROUTING chain to se

t is then inspected by
e whether the packet requires DNAT. 1t

is then routed.
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If the packet is destined for a protected network, then it is filtered by
the rules in the FORWARD chain of the filter table and, if necessary, the

packet undergoes SNAT before arriving at Network B. When the destination

server decides to reply, the packet undergoes the same sequence Of steps.

If the packet is destined for the firewall itself, then it is filtered by the
rules in the INPUT chain of the filter table before being processed by the
intended application on the firewall. At some point, the firewall needs t0
reply. This reply is inspected by your cules in the OUTPUT chain of the
mangle table, if any. The rules in the OUTPUT chain of the nat table
determine whether address translation is required and the rules in the
OUTPUT chain of the filter table are then inspected before the packet is

routed back to the Internet.

12



44.3 Packet Filtering Tables

Queue | Queue

Type ‘Function

Packet
Transformation

chain in Queue

Chain Function

ilter

acket

filtering

FORWARD

Filters packets to S€rvers
accessible by another NIC on

the firewall.

INPUT

Filters packets destined to

the firewall.

OuTPUT

Filters packets originating

from the firewall

iNat

Network
Address

Translation

PREROUTING

Address translation occurs
before routing. Facilitates the
transformation of  the
destination IP address to be
compatible with the
firewall's routing table. Used
with NAT of the destination
[P address, also known as

destination NAT or DNAT.

POSTROUTING

Address translation occuis

after routing. This implies




that there was no need to

modify the destination 1P

address of the packet as in

pre-routing. Used with NAT

of the source [P address

using either one-to-one oOr
many-to-one NAT. This is
known as source NAT, or

SNAT.

Network address translation
for packets generated by the

firewall.
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4.4. Displacement of rules to different chains

Routing
Decision

Incoming Outgoing

Fig No.4.3 General Packet Processing

ACCEPT everything

[RCCE
from LAN to Internet ES

PT everything
| _TA‘BLISHED' or
RELATED

Fig No.4.4 Forward chain

We want the local network to be able to connect to the Internet, of
course. To do this, We will need to NAT all packets since none of the local
computers have real 1P addresses. All of this 1s done within the
PREROUTING chain. . This means that we will also have to do some
filtering within the FORWARD chain since W¢€ will otherwise allow
outsiders full access to our local network. We trust our jocal network to the
fullest, and because of that we specifically allow all traffic from our local

network 10 the Internet. Since no one on the Internet should be allowed 1o

15



contact our Jocal network computers, W€ will want to block all traffic from
the Internet to our local network except already established and related
connections, which in turn will allow all return traffic from the Internet to

our local network.

o ite LM tED. iae L 'udpin_cnmi-ng_‘ .'--Léca!;hnst
iemp T_;;”:ackets_.\f tcp,_packets. _’:{,pﬁbke’ts- .{ Localnet

Fig No.4.5 Input chain

As for our firewall, we just want to offer a few services to people on
the Internet. Therefore, we have decided to allow HTTP, F1P, §SH access
to the actual firewall. All of these protocols are available on the actual
firewall, and hence it should be allowed through the INPUT chain, and we
need to allow the return traffic through the OUTPUT chain. However, we
also trust the local network fully, and the loopback device and TP address are
also trusted. Because of this, we want t0 add special rules to allow all traffic
from the local network as well as the loopback network interface. Also, we
do not -want 1O allow specific packets of packet headers in specific
conjunctions, nor do we want to allow some IP ranges to reach the firewall
from the Internet. For instance, the 10.0.0.0/8 address range is reserved for
Jocal networks and hence we would normally not want to allow packets from

such a address range since they would with 90% certainty be spoofed.

16



Since we have an FTP server running on the server, as well as the fact
we want to traverse as few rules as possible, we add a rule which lets all
established and related traffic through at the top of the INPUT chain. For the
same reason, we want to split the rules down into sub-chains. By doing this,
our packets will hopefully only need to traversc as few rules as possible. By
traversing less rules, We make the rule-set less time consuming for each

packet, and reduce redundancy within the network.

We chose to split the different packets down by their protocol family,
for example TCP, UDP or ICMP. All TCP packets traverse a specific chain
named tcp_packets, which will contain rules for all TCP ports and protocols
that we want to allow. Also, we want to do some extra checking on the TCP
packets, sO W would like to create one more subchain for all packets that
are accepted for using valid port numbers to the firewall. This chain we
choose to call the allowed chain, and should contain a few extra checks
before finally accepting the packet. As for [CMP packets, these will traverse
the icmp_packets chain. When we decided on how to create this chair, we
could not see any specific needs for extra checks before allowing the ICMP
packets through if we agree with the type and code of the ICMP packet, and
hence we accept them directly. Finally, we have the UDP packets which
need to be dealt with. These packets, we send to the udp_packets chain
which handles all incoming UDP packets. All incoming UDP packets should
be sent to this chain, and if they are of an allowed type we should accept

them immediately without any further checking.

17



7~ ouTPuT ™
_ POLICY: DROP

ACGEPT aveiything] _gJACCEPT evergthing ACCEPT everdhing
from 127.0.0.4 Pirom 1926812 | Pjiiom 194236.50.155

Fig No.4.6 Output chain

Finally, we have the firewalls OUTPUT chain. Since we actually trust
the firewall quite a lot, we allow pretty much all traffic leaving the firewall.
We do not do any specific user blocking, nor do we do any blocking of
specific protocols. However, we do not want people to use this box to spoof
packets leaving the firewall itself, and hence we only want to allow traffic
from the IP addresses assigned to the firewall itself. We would most likely
implement this by adding rules that ACCEPT all packets leaving the firewall
in case they come from one of the IP addresses assigned to the firewall, and

if not they will be dropped by the default policy in the QUTPUT chain.

4.5. Using Firewall Manager
4.5.1 Overview

a) Create objects in object tree

b) Create 2 Managed Firewall object

¢) Add and/or edit firewall rules
d) Add and/or edit NAT rules

13



e) Install Policy
4.5.2 Creating Objects

There are a few major categories of objects you cail create, some with
sub-categories. Network Objects represent networked objects with 1P
addresses. The sub-classes include Host (single 1P}, Network (contiguous
range of IPs), Managed Firewall , and Group (any combination of the above
objects). Service objects represent 2 certain type of IP connection, in the
case of TCP ot UDP that includes source and destination ports, and for
ICMP that includes ICMP type and code. To create an object, right-click on
the folder in the tree in the left panel of Firewall Manager and click ADD.
Define your object in the resulting dialog box and click OK.Common
services come pre-deﬁned, but you will need to define hosts, networks, and
at least one Managed Firewall (required 10 generate scripts and install
policies).

4.5.3 Creating Firewall Rules

Click Edit -> Add Rule, to add a new blank rule to your current active
policy. Some cells can be edited by right-clicking the cell and choosing Edit
Cell. Rates and Actions are just drop down boxes, Log is just a checkboX,
and comments can be entered by clicking on the comment cell and typing.
The firewall will look for packets matching the source, destination, service
and rate of the packet. 1f it gets @ match, it will do the action chosen in the
Action column. Accept means the packet will be forwarded as necessary,
Drop means the packet will not be allowed to pass, and Deny means the
packet will not be allowed to pass, but a message will be sent back to the
source, notifying it that the packet was not allowed. In addition, the match
will also be logged if the logged box is checked. If the packet is not

matched, the firewall will consult the next rule down the list. By default, at

19



the end of every rule list, Firewall Manager configures the firewall to drop
anything that doesn't match. Firewall Manager tries to account for
statefullness. Meaning that responses from 2a TCP connection are
automatically allowed to retur, without you needing t0 specify a rule for
that. For UDP, a rule is opened for return packets also, even though UDP is
stateless. For ICMP, rules need to be created in both directions.

4.5.4 Creating NAT Rules

Creating NAT rules are similar to firewall rules, but click on the NAT
tab in the main window first. In NAT rules though, the firewall will look for
matches in the Original columns (Source, Destination and Service), and if it
gets a match, will change the IPs to the corresponding Translated column
entry.

4.5.5 Saving Policy

Use File -> Save or File -> Save As to save your policy. This creates a
local copy of your policy for later use. This should be done before trying to
install your policy.

4.5.6 Installing Policy

Use Policy -> Install to install your policy. A list of all your defined
ManagedFirewalls will be presented, and you can choose one of more to
install to. This will create a local copy of your iptables script, COPY it to the
remote firewall (using scp Of sfip, so sshd will need to be running on the
remote firewall), chmod it if required and execute it to make it active
immediately. Alternatively, you can use Policy -> Generate Scripts to create

a local copy of your iptables scripts, and then copy and execute manually.

20



5. FEATURES OF FIREWALL MANAGER

Firewall Managet is easily customizable. Thijs means that you can add

or remove filters based on several conditions. gome of these are:

. 1P ADDRESS - Each machine on the Internet is assigned a unique

address called an 1P address. 1P addresses are 32-bit numbers,
normally expressed as four "octets” in a "dotted decimal number.” A
typical 1P address looks like this: 216.27.61.137. For example, if a
certain 1P address outside the company is reading to0 many files from
a server, the firewall can block all traffic to or from that 1P address.

DOMAIN NAMES - Because it is hard 10 remember the string of
aumbers that make up an 1P address, and because 1P addresses
sometimes peed to change all servers on the Internet also have
human—readable names, called domain names. For example, it 18
easier for most of us to remember www.linwinQ.kAt.com than it 1s 10
remember 116.27.61.137. A company might block all access to
certain domain names or allow access only to specific domain names.
PROTOCOLS - The protocol is the pre-defined way that someone
who wants to use @ service talks with that service- The nsomeone”
could be a person, but more often 't is a computer program like a Web
browser. Protocols are often text, and simply describe how the client
and server will have their conversation. The http in the Web's
protocol. Some common protocols that you can set firewall filters for

include:

21



o IP (Internet Protocol) - the main delivery system for
information over the Internet

o TCP (Transmission Control Protocol) - used to break apart and
rebuild information that travels over the Internet

o HTTP (Hyper Text Transfer Protocol) - used for Web pages

o FTP (File Transfer Protocol) - used to download and upload
files

o UDP (User Datagram Protocol) - used for information that
requires no response such as streaming audio and video

o ICMP (Internet Control Message Protocol) - used by a router to
exchange the information with other routers

o SMTP (Simple Mail Transport Protocol) - used 1O send text-
based information (e-mail)

o SNMP (Simple Network Management Protocol) - used 1O
collect system information from a remote computer

o Telnet - used to perform commands on a remote computer

A company might set up only one or two machines to handle a

specific protocol and ban that protocol on all other machines.

e PORTS - Any server machine makes its Services available to the
Internet using numbered ports, one for each service that is available
on the server (see How _Web Servers Work for details). For examplc,
if a server machine is running 2 Web (HTTP) server and an FTP
server, the Web server would typically be available on port 80, and
the FTP server would be available on port 21. A company might block

port 21 access OO all machines but one inside the company.

22



Firewall Manager is a software firewall that can be installed on the

er in your home that ha

s an Internet connection. This computer is

des the only point of access between

comput
gateway because it provi

and the Internet.

considered a

your home network



6. PRODUCTY TESTING

Testing is done 10 detect the errors in the software. This implies not
only to the coding phase but to uncover errors introduced in all the previous
phases.

The following are the types of tests that were performed-

Unit testing: Each and every module is tested separately to check if its
intended functionality is met. Some unit testing performed are,
- Checking the proper working of the iptables and sshd.
. Checking for proper connectivity between server and client .
. Ensuring that the input, output and forward module works and does
not interfere with other functions.
- Checking the working of the services such as Telnet, FTP, SMTP,
HTTP, PING.
Integration testing: It is the testing performed to detect errors on
interconnection between modules. Here, the system 1S integrated with
iptables and kernel, and tested that the scripts are executed in the runlevel.
System testing: The system is iested against the system requirements 10 se€
if all the requirements are met and if the system performs as per the
specified requirements. The system is tested as a whole 10 check for its
functionality.
Validation testing: This test \s done to check for the validity of the entered
input. The input to this system are the host IPAddress, Protocol type and the
administrator’s user id and password. Invalid characters and symbols are

recognized and properly handled.

24



7. FUTURE ENHANCEMENTS

- Deploy and run scripts on remote firewalls

_ Perform certain management or status tasks on remote firewalls
. Auditing of all policy changes

- Undo changes functionality

- Importing of objects, services, or rules from other policies

- Drag and Drop
- IPv6 support
- Support for other types of firewalls besides iptables.

25



8. CONCLUSION

A firewall is a critical part of any establishment that connects to an
unprotected network such as the Internet. This application can help
administrators create a strong firewall with the powerful, kernel-based
firewall software. This application reduces the administrator’s time in setting
up a firewall thereby improving the security of the network. It is scalable
and can be deployed in any environment ranging from home to larger
networks. This enables administrators to protect their servers from a wide

variety of hazards, including service attacks and hack attempts.

This application finds its usage in software industry where they want
to protect their valuable data from both internal and external malicious users.
It also enables particular services to be allowed or denied thus enriching
more security to the network. This application also finds use in educational
institutes where they want to restrict the user from viewing unethical sites. It

can also be used in web browsing centers, home etc.
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APPENDIX 1

Adding Rules

import javax.swing.JTabbedPane;

import javax.swing.AbstractAction;
import javax.swing.JFrame;

import java.awt.event.ActionEvent;
import javax.swing.event.ChangeListener;
import javax.swing.event.ChangeEvent;
import java.util.Vector;

import java.util. Enumeration;

import java.util.List;

public class TableAdd extends AbstractAction implements ChangeListener {

private JWallMain jwall;

private int mode = 0;

public final static int MODE_FW  =0;
public final static int MODE_NAT =1;

public TableAdd(JWallMain jwall) {
super(PropertyManager.getString("menu.table.add.object"));
this.jwall = jwall;

}

public void actionPerformed(final ActionEvent e} {
Policy policy = PolicyManager.getInstance().getActivePolicy();
switch {mode) {
case MODE_FW:
FWTable fwTable = jwall.getF WTable();
int col = fwTable.getSelectedColumn();
int row = fwTable.getSelectedRow();
FWRule rule = fwTable.getF WRule(row);
Vector to = new Vector();

if (col == FWTable.COL_SRC) {
Enumeration en = rule.enumSources();
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while (en.hasMoreElements()) {

to.add(en.nextElement());

i)
J

Vector from = new Vector();
NetworkObject[] nos = policy.getNetworkObjects();
for (int i = 0; i < nos.length; i++) {
if ('to.contains(nos(i]}) {
from.add(nos[i]);

}
}

MultiObjectChooser moc =
MultiObjectChooser.getInstance((JFrame) jwall,
PropertyManager.getString("fwcol.1"),
PropertyManager.getString(" gui.moc.src.msg"),
from, to, true);
List list = moc.getSelection();
if (list = null} {
rule.setSources(list);
fwTable.adjustRowHeights();
1

MultiObjectChooser.releaselnstance();

} else if (col == FWTable.COL_DEST) {
Enumeration en = rule.enumDestinations();
while (en.hasMoreElements(}) {

to.add(en.nextElement());
}

Vector from = new Vector();
NetworkObject[] nos = policy.getNetworkObjects();
for (int i = 0; 1 < nos.length; i++) {
if (!to.contains(nos[i])) {
from.add(nos[1]);
}

}
MultiObjectChooser moc =

MultiObjectChooser.getInstance((JFrame) jwall,
PropertyManager.getString("fwcol.2"),
PropertyManager.getString("gui.moc.dest.msg"),
from, to, true);

List list = moc.getSelection();
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if (list 1= null) {
rule.setDestinations(list);
fwTable.adjustRowHeights();

MultiObjectChooser.releaseInstance();
} else if (col == FWTable.COL_SERV) {
Enumeration en = rule.enumServices();
while (en.hasMoreElements()) {
to.add(en.nextElement());
}
Vector from = new Vector();
Service[] servs = policy.getServices();
for (inti=0;1< servs.length; it++) {
if (!to.contains(servs[i])) {
from.add(servs[i});

}

}
MultiObjectChooser moc =
MultiObjectChooser. getInstance((JFrame) jwall,
PropertyManager. getString(“fwcol.B"),
Pr0pertyManager.getString(" gui.moc.serv.msg“),
from, to, true);
List list = moc. getSelection();
if (list !=null) {
rule.setServices(list);
fwTable.adjustRowHeights();

MultiObjectChooser.releaseInstance();

3

break;

case MODE_NAT:

NATTable natTable = jwall. getNATTable();

int natCol = natTable. getSelectedColumn();

int natRow = natTable.getSelectedRow( );

NATRule natRule = natTable. getNATRule(natRow);

Vector natTo = new Vector();

if (natCol == NATTable.COL_O_SRC) {
Enumeration en = natRule.enumOriginalSources();
while (en.hasMoreElernents()) {

natTo.add(en.nextElement(});



Vector from = new Vector();
NetworkObject[] nos = policy.
for (inti=0;1< nos.length; i++) {
if (!natTo.contains(nos[i])) {
from.add(nos{i});

3

}
MultiObjectChooser moc =

MultiObjectChooser.getInstance(jwall,
PropertyManager. getString(“natcol. 1),
PropertyManager.getString("gui.moc.src.msg"),
from, natTo, true);
List list = moc.getSelection();
if (list 1= null) {
natRule.setSources(list);
natTable.adjustRowHeights();

getNetworkObjects();

MultiObjectChooser.releaselnstance();

_ NATTable.COL_O_DEST) {

Y else if (natCol =
atRule.enumOriginalDestinations();

Enumeration en =
while (en.hasMoreElements()) {

natTo.add(en.nextElernent());

Vector from = new Vector();
NetworkObject[] nos = policy.getNetworkObjects();
for (inti=10;1< nos.length; i++) {
if (!natTo.contains(nos[i])) {
from.add(nos{i});

3

}
MultiObjectChooser moc =

MultiObjectChooser.getlnstance((JFrame) jwall,
PropertyManager. getString(“fwcol.Z"),

PropertyManager.getString(“ gui.moc.dest.msg"),

from, natTo, true);
List list = moc.getSelection();

if (list !=null) {
natRule.setDestinations(list);
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natTable.adjustRowHeights();

MultiObjectChooser.releaselnstance();

y else if (natCol == NATTable.COL_O_SERV) {
Enumeration en = natRule.enumOriginalServices();
while (en.hasMoreElements()) {

natTo.add(en.nextElement());
}
Vector from = new Vector();
Service[] servs = policy. getServices();
for (inti=0;1< servs.length; i++) {
if (!natTo.contains(servs[i])) {
from.add(servs[i]);

}

MultiObjectChooser moc =
MultiObjectChooser. getInstance((J Frame) jwall,
PropertyManager. getString(“fwcol.3"),
PropertyManager.getString(" gui.moc.serv.msg"),
from, natTo, true);
List list = moc.getSelection();
if (list '=null) {
natRule.setServices(list);
natTable.adjustRowHeights();

MultiObjectChooser.releaselnstance();
} else if (natCol == NATTable.COL_X_SRC) {
ObjectListDialog old = new ObjectListDialog(jwall,
policy.getNetworkObj ects(),
PropertyManager. getString(" gui.policy.choose™), false);
Object[] obj = old.getSelectedObjects();
if (obj.length > 0) {
NetworkObject xSrc = (NetworkObject) obj (01
if (xSre !=null) {
natRule.setXlatedSource(xSrc);
natTable.adjustRowHeights();
natTable.setValueAt(xSrc, natRow, natCol);

}
}
} else if (natCol == NATTable.COL_X_DEST) {
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ObjectListDialog old = new ObjectListDialog(jwall,

policy.getNetworkObjects(),
PropertyManager. getString("gui.policy.choose"), false);
Object[] obj = old.getSelectedObjccts();
if (obj.length > 0) {
NetworkObject xDest =
if (xDest 1= null) {
natRule.setXlatedDestination(xDest);
natTable.adjustRowHeights();
natTable.setValueAt(xDest, natRow, natCol);

(NetworkObject) obj[0);

3

}
) else if (natCol == NATTable.COL_X_SERYV) {
ObjectListDialog old = new ObjectListDialog(jwall,

policy.getServices(), PropertyManager. getString(" gui.policy.choose"),

false);
Object[] obj = old.getSelectedObjects();

if (obj.length > 0) {
Service xServ = (Service) obj[0];
if (xServ !=null) {
natRule.setXlatedService(xServ);

natTable.adjustRowHeights();
natTable.setValueAt(xServ, natRow, natCol);

public void stateChanged(ChangeEvent e) {
jTabbedPane tab = (J TabbedPane) e.getSource(};
switch (tab.getSelectedIndex()) {
case MODE_FW:
mode = MODE_FW;

break;
case MODE_NAT:
mode = MODE_NAT;

break;



S

Policy Generate

import javax.swing.*;

import java.awt.event.ActionEvent;
import java.io.File;

import java.io.IOException;

import java.io.InputStream;

import java.util.logging.Level;
import java.util.logging.Logger;

public class PolicyGenerate extends AbstractAction {

private static Logger logger = Logger.getLogger("org.jwall. gui.handler");
private JFrame frame;
private Preference prefs =

PreferenceManagerInstance. getInstance().getPreference();

public PolicyGenerate(JFrame frame) {
super(PropertyManager.getString("menu.policy.generate"));
this.frame = frame;

}

public void actionPerformed(final ActionEvent e) {
Policy activePolicy = PolicyManager. getInstance(). getActivePolicy();
ManagedFirewall[] firewalls = activePolicy.getFirewalls();
Object[] list = new Obj ect[firewalls.length];
for (inti=0;i< firewalls.length; i++) {
list[i] = firewalls[i];
}
ObjectListDialog old = new ObjectListDialog(frame, list,
PropertyManager. getString(" gui.policy.choose"), true);
Object(] selected = old.getSelectedObjects();
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for (int f=0; < selected.length; f++) {
File fwScript = null;
JFileChooser fc = new JFileChooser();
fc.setCurrentDirectory(prefs.getDirConﬁguration());
int retVal = fc.showSaveDialog(frame);
if (retVal == JFileChooser.APPROVE_OPTION) {
fwScript = fc.getSelectedF ile();
if (!wacript.getName().endsWith(".sh")) {
fwScript = new File(fwScript + ".sh");

3
if (activePo]_icy_isModiﬁed()) {

PolicyManager. getInstance().saveActivePolicy();
.

5
if (!activePolicy.isModiﬁed()) {
[PTablesParser parser = new [PTablesParser();
parser. generateScript(activePolicy,
activePolicy.getFirewalls()[0], fwScript);
me.setStatus("Script saved to " + fwScript. getAbsolutePath());

}
else {
logger.log(Level.WARNTNG, "Policy: "

activePolicy.getName() + " was not saved, so no script was created");

}

}
}
}

3
Policy Install

import javax.swing.*;
import java.awt.event.ActionEvent;
import java.io.*;

public class Policylnstall extends AbstractAction {
private final JFrame frame;
private Preference prefs =
PreferenceManagerInstance.getInstance().getPreference();



public Policylnstall(JFrame frame) {
super(PropertyManager.getString("menu.policy.install"));
this.frame = frame;

}

public void actionPerformed(final ActionEvent e) {
Policy activePolicy = PolicyManager.getInstance().getActivePolicy();
ManagedF irewall] firewalls = activePolicy.getFirewalls();
Object[] list = new Object[ﬁrewalls.length];
for (inti=0;1i< firewalls.length; i++) {
list{i] = firewalls[i];

ObjectListDialog old = new ObjectListDialog(frame, list,
PropertyManager. getString(" gui.policy.choose"), true);
Object(] selected = old.getSelectedObjects();

TextViewer tv = new TextViewer(frame,
PropcrtyManager.getString("menu.policy.install"));

for (int f=0; f< selected.length; f++) {
ManagedFirewall wall = (ManagedFirewall) selected[fl;

File fwScript = new File(prefs.getDirGeneratedScripts().toString() +
System.getProperty("ﬁle.separator") + wall.getName() + ".auto");

File fwStopScript = new
File(prefs.getDirGeneratedScripts().toString() +
System.getProperty("ﬁle.separator") + wall.getName() + " stop");

File rcScript = new File(prefs.getDirGeneratedScripts().toString() +
System.getProperty("ﬂle.separator") + wall.getName() + "rc");

[PTablesParser parser = new [PTablesParser();

parser.generateScript(activePolicy, wall, fwScript);

parser. generateStopScript(activePolicy, wall, fwScript);

parser.generateRCScript(wall, reSeript);

Connection conn = wall.getConnection();

tv.append("Authenticating. M)

conn.connect();

tv.append("Transfering firewall script...");

conn.put(wacript.getAbsolutePath(), wall.getFWScriptPath(), 0700,
wall.isUseSudo());
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ty.append("Creating rc script”);
conn.put(rcScript.getAbsolutePath(), wall.getRCScriptPath(), 0700,
wall.isUseSudo());

tv.append("Creating symlinks..."};
InputStream in = conn.execute("/bin/ln -s " + wall. getRCScriptPath()

4" fete/rc3.d/S05jwall 2>&1\n”, wall.isUseSudo(});
try {
byte buffer{] = new byte[255);
int read;

while ((read = in.read(buffer)) > 0) {
String out = new String(buffer, 0, read);

tv.append(out);
3

3
catch (JOException ioe) {
System.out.println(ioe);

}
in = conn.execute("/bin/ln -s "o+ wall.getRCScriptPath() + "

5.d/S05jwall 2>&1\n", wall.isUseSudo());
{

fete/r

ry {
byte buffer[] = new byte[255];
int read;
while ((read = in.read(buffer)) > 0) {
String out = NEW String(buffer, 0, read);

tv.append(out);

}

}
catch (IOException ioe) {
System.out.println(ioe);

j

tv.append("Executing script...");

in = conn.execute("/bin/sh "+ wa
wall.isUseSudo());

try {
byte buffer[] = new byte[255];

int read;
while ((read = in.read(buffer)) > 0) {

String out = new String(buffer, 0, read);
tv.append(out);

ll.getFWScriptPath() +" 2>&1\n",

}
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catch (JOException i0€) {
System.out.println(ioe);

tv.append("Disconnecting.. MY
conn.disconnect();
tv.append(“Complete.");

Policy Uninstall

import javax.swing.* ;

import java.awt.event.ActionEvent;
import java.io.IOException;

import java.io.InputStream;

public class PolicyUninstall extends AbstractAction {
private final JFrame frame;

public PolicyUninstall(JFrame frame) {
super(PropertyManager.getString("menu.policy.uninstall"));
this.frame = frame;

}

public void actionPerformed(final ActionEvent €) {
Policy activePolicy = PolicyManager.getlnstance().getActivePolicy();
ManagedF irewall[] firewalls = activePolicy.getFirewalls();
Object[] list = new Object[ﬁrewalls.length];
for (inti=0;1< firewalls.length; i++) {
list[i] = firewalls[i];

ObjectListDialog old = new ObjectListDialog(frame, list,
PropertyManager.getString(" gui.policy.choose"), true);
Objectl] selected = old.getSelectedObjects();



TextViewer tv = new TextViewer(frame,
PropertyManager.getString("menu.policy.uninstall"));

for (int £ = 0; f < selected.length; f++) {
ManagedFirewall wall = (ManagedFirewall) selected[f];

Connection conn = wall.getConnection();
tv.append("Authenticating...");
conn.connect();
tv.append("Stopping firewall...");
InputStream in = conn.execute(wall.getRCScriptPath() + " stop
2>&1\n", wall.isUseSudo());
try {
byte buffer[] = new byte[255];
int read;
while ((read = in.read(buffer)) > 0} {
String out = new String(buffer, 0, read);
tv.append{out);

}
}

catch (IOException ioe) {
System.out.printin(ioe);
}
}
}
}



APPENDIX 2

Adding New Rules

) new policy
@ [ Newwork Objects
@ [ Hosts
Syl
Sys2
" 2 Networks
4 Groups
© [ Managed Firewalls
5 Firewall
VPN Peers
fo I Rates
§ ¢ EDserces
i emter :
FTP-controk
NTT? ,,
HTTP/S !
IMAR4 ,
LOAP
MS-5QL
MS-TarmServ |
NNTP |
NTP ;§ ,‘
T Oracle B Il
T POP3
T SMTP I
T SH ’ "
T Telnet 3 t i
|

“Taccept FTP senvce
¥ Drop Telnet Request

T _FTP-control - jnone .

T Tenet none s DroOp

B e R e e

T X1l
T eDonkey 1
T eDonkey?
& C3uoP
U DNS-Query
U SNMP
1 SNMP-TRAP
4 Syslog
 Chewe
3 Osher
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Define Host Object

™) new policy
19 O Network Objects
§ [ Hosts
Sysl
Sys2
- ] Networks
4 Groups
© 1 Managed Firewalis
B rirewal
VPN Peers
J o CIRates
® CYSerdces
9 CITer
. FTP-control
HTTP
HTTP/S
IMAP4
LDAP
M3-3QL
MS-TermSery
NNTP
NTP
Oracle
POP3
SMTP
SSH

N L |

T x11
T eDonkey 1
- T eDonkey 2
¢ Cuoe
U DNS-Query
U SNMP
U SNMP-TRAP
U Syslop
3 1cmp
(I Other

"7 FTP-tontrof

‘T Telnet

(7 iaccept FTP Servce
¥ Drop Telnet Request
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Define Network Object

R
3 new policy
© [ Network Qbjects
&Ekosts

T Neworks

- CGroups
§ 3 Managed Firewalls
- EiFrewall

VPN Peers
30 Rates
fo Mservices
e (ATce

T FTP-contral

i T HTTP
T HTTP#S
T IMAP4
T LDAP
T MS-SQL
T MS-Termseny
T NNTP
T NTP
T Oratle
T POP3
T SWTP
T SH
T Telnet
T X111
-1 eDonkey 1
T eDonkey 2
& Juoe
U DNS-Query
L SNMP
U SNMP-TRAP
U Sysieg
CicMP
9 e
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Defining services

I new policy
@ ™) Network Gb)ects
&= (7% Hosts
[ Networks
[ Greups
© [ Managed Firewalls
22 Firewall
VPN Peers
e Rates
© CServices
@ LATCP
. FTP-controt
HTTP
HWTTPSS
IMAP4
iDAP
M5-SQL
M5-TermSery
NNTP
NTP
Dracle
POP3
SMTP

[ e bt B i

T X11
T eDonkey 1
T eDonkey 2
¢ CZluoe
U DNS-Query
U SNMP
U SNMP-TRAP
U Syslog
-~ EeMp
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Defining Firewall Object

% new policy
19 ENework Objects
9 CHos
Sys2
- C Neworks
1 Groups
. @ (3 Managed Firewalls
' 5 rirewal)
VPN Peers
1o 3 rates
@ none
£ CI5enices
o CATee
© T FTP-control
T HTTP
T HTTPS
T IMAPY
T LD&P
T MS-5QL
T MS-Termserv
T NNTP
T NTP
T Oracle
- T POP3
T SMTP
T SSH
T Telnet
T x11 d :
T eDonkey 1 E i
T eDonkey2 E E'
@ CJuop : ;;
U DNS-Query ‘
) SNMP N !
U SNMP-TRAP : |
U Syslog l |

W Accept ¥

Lo iDrﬂpTeInelRequest

Cdicwe ;
Other
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